
Allied Telesis x610 Series Layer 3+ switches offer an impressive set 
of features in a high-value package, ideal for enterprise network 
applications.

The Allied Telesis x610 Series is a 
high performing and scalable solution 
for today’s networks, providing an 
extensive range of port-density and 
uplink-connectivity options. With a 
choice of 24-port and 48-port versions 
and optional 10 Gigabit uplinks, plus the 
ability to stack up to eight units, the x610 
Series can connect anything from a small 
workgroup to a large business. 

High Performing
Flexible endpoint deployment is ensured 
with the ability to power devices such 
as IP phones, security cameras, and 
wireless access points directly from the 
switch. This convergence of voice, video 
and data on today’s networks is enabled 
by Power over Ethernet Plus (PoE+), 
which has the added benefit of reducing 
costs. 

Multiple customers can have their own 
secure virtual network within the same 
physical infrastructure, as the x610 
Series switches are able to divide a 
single router into multiple independent 
virtual routing domains. Layer 3 network 
virtualization provided by Virtual Routing 
and Forwarding (VRF Lite) creates 
independent routing domains, where IP 
addresses can overlap without causing 
conflict.

Non-blocking architecture guarantees 
wirespeed delivery of all critical IPv4 
and IPv6 traffic. Maximum availability 
of premium services and applications is 
effortless, with industry-leading Quality 

of Service (QoS) features managing 
network responsiveness.

Resilient
Uninterrupted access to  
online applications is provided by 
implementing a network with no single 
point of failure. Distributing resources 
across a stacked group of units means 
no network downtime. A fully resilient 
solution is created with Virtual Chassis 
Stacking (VCStack™), where up to eight 
units can form a single virtual chassis, 
with dual connections to key servers 
and access switches. Virtual Chassis 
Stacking can be implemented in the 
same cabinet over copper cabling, or to 
remote locations using fiber.

A high-speed solution where recovery 
occurs within as little as 50ms can 
be deployed in ring-based topologies. 
Several switches can form a protected 
ring, running at up to 10Gbps. This 
high performing resilient design for 
distributed networks is made possible 
with Allied Telesis Ethernet Protection 
Switching Ring (EPSRing) technology.

Scalable
The flexibility of the x610 Series, coupled 
with the ability to stack multiple units, 
ensures a future-proof network. An 
extensive range of port-density and 
uplink-connectivity options enables 
network connectivity for any size of 
business. The choice of 24-port and  
48-port versions and the choice of 
Gigabit or 10 Gigabit uplink ports allows 

tailoring of the uplink bandwidth to 
suit network applications. Expansion 
modules are available for local and long-
distance stacking or can be configured to 
provide two additional 10G ports.

Secure
Advanced security features protect 
the network from the edge to the 
core. Unprecedented control over user 
access is provided with Network Access 
Control (NAC), to mitigate threats to 
network infrastructure. This ensures 
the network is accessed only by known 
users and devices, as users’ adherence to 
network security policies is checked and 
access granted or remediation offered. 
Secure access can also be provided for 
guests.

A secure network environment is 
guaranteed, with powerful control 
over network traffic types, secure 
management options, and other multi-
layered security features built into the 
x610 Series switches.

What’s New
»» OSPFv3

»» VRF»Lite

»» TACACS+»authentication

»» Improved»VCStack»management

»» Eco-friendly»support

»» Long-distance»stacking

»» Front»to»back»cooling

alliedtelesis.com
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Virtual Routing and Forwarding (VRF Lite) 

»» VRF»Lite»provides»Layer»3»network»virtualization»by»
dividing»a»single»router»into»multiple»independent»
virtual»routing»domains.»With»independent»routing»
domains,»IP»addresses»can»overlap»without»causing»
conflict,»allowing»multiple»customers»to»have»their»
own»secure»virtual»network»within»the»same»physical»
infrastructure.

VCStack

»» Create»a»VCStack»of»up»to»eight»units»with»48Gbps»of»
stacking»bandwidth»to»each»unit.»VCStack»provides»a»
highly»available»system»where»network»resources»are»
spread»out»across»stacked»units,»reducing»the»impact»
if»one»of»the»units»fails.»Aggregating»switch»ports»on»
different»units»across»the»stack»provides»excellent»
network»resiliency.

Mixed Stacking

»» The»x610»Series»is»compatible»with»the»x600»Series»
in»a»mixed»VCStack»of»up»to»four»units.

Long-distance Stacking

»» Long-distance»stacking»allows»a»VCStack»to»
be»created»over»longer»distances,»perfect»for»a»
distributed»network»environment.

Ethernet Protection Switching Rings (EPSRing)

»» EPSRing»and»10»Gigabit»Ethernet»allow»several»x610»
switches»to»form»a»high-speed»protected»ring»capable»
of»recovery»within»as»little»as»50ms.»This»feature»is»
perfect»for»high»performance»and»high»availability»in»
enterprise»networks.

Easy to Manage

»» Allied»Telesis»x610»Layer»3+»switches»run»the»
advanced»AlliedWare»Plus™»Layer»3»fully»featured»
operating»system,»delivering»a»rich»feature»set»and»an»
industry-standard»CLI.»In»addition»to»the»CLI,»x610»
switches»feature»a»comprehensive»GUI»for»easy»
access»to»monitoring»and»configuration.

Key Features
Access Control Lists (ACLs)

»» AlliedWare»Plus»delivers»industry-standard»Access»
Control»functionality»through»ACLs.»ACLs»filter»
network»traffic»to»control»whether»routed»packets»
are»forwarded»or»blocked»at»the»port»interface.»This»
provides»a»powerful»network»security»mechanism»to»
select»the»types»of»traffic»to»be»analyzed,»forwarded,»
or»influenced»in»some»way.

Industry-leading Quality of Service (QoS)

»» Comprehensive»low-latency»wirespeed»QoS»provides»
flow-based»traffic»management»with»full»classification,»
prioritization,»traffic»shaping»and»min/max»bandwidth»
profiles.»Enjoy»boosted»network»performance»and»
guaranteed»delivery»of»business-critical»Ethernet»
services»and»applications.»Time-critical»services»such»
as»voice»and»video»take»precedence»over»non-essen-
tial»services»such»as»file»downloads,»maintaining»
responsiveness»of»Enterprise»applications.»

Power over Ethernet Plus (PoE+) 

»» With»PoE,»a»separate»power»connection»to»media»
endpoints»such»as»IP»phones»and»wireless»access»
points»is»not»necessary.»PoE+»provides»even»greater»
flexibility,»providing»the»capability»to»connect»devices»
requiring»more»power»(up»to»30»Watts)—for»example,»
tilt»and»zoom»security»cameras.

»» A»redundant»PoE+»high-availability»solution»can»be»
built»using»VCStack»and»additional»RPS»units.»See»the»
x610»PSU»PoE»options»table»on»page»5»for»details.

Link Layer Discovery Protocol – Media 
Endpoint Discovery (LLDP – MED)
»» LLDP-MED»extends»LLDP»basic»network»endpoint»
discovery»and»management»functions.»LLDP-MED»
allows»for»media»endpoint»specific»messages,»
providing»detailed»information»on»power»requirements,»
network»policy,»location»discovery»(for»Emergency»
Call»Services)»and»inventory.»

Voice VLAN

»» Voice»VLAN»automatically»separates»voice»and»data»
traffic»into»two»different»VLANs.»This»automatic»
separation»places»delay-sensitive»traffic»into»a»voice-
dedicated»VLAN,»which»simplifies»QoS»configurations.

Open Shortest Path First (OSPFv3)

»» OSPF»is»a»scalable»and»adaptive»routing»protocol»for»
IP»networks.»The»addition»of»OSPFv3»adds»support»
for»IPv6»and»further»strengthens»the»Allied»Telesis»
focus»on»next»generation»networking.

Network Access Control (NAC)

»» NAC»allows»for»unprecedented»control»over»user»
access»to»the»network,»in»order»to»mitigate»threats»to»
network»infrastructure.»Allied»Telesis»x610»switches»
use»IEEE»802.1x»port-based»authentication»in»
partnership»with»standards-compliant»dynamic»VLAN»
assignment,»to»assess»a»user’s»adherence»to»network»
security»policies»and»either»grant»access»or»offer»
remediation.»

»» If»multiple»users»share»a»port,»then»multi-
authentication»can»be»used.»Different»users»on»the»
same»port»can»be»assigned»into»different»VLANs,»
and»so»given»different»levels»of»network»access.»
Additionally,»a»guest»VLAN»can»be»configured»to»
provide»a»catch-all»for»users»who»aren’t»authenticated.

Tri-authentication

»» Authentication»options»on»the»x610»Series»also»
include»alternatives»to»IEEE»802.1x»port-based»
authentication,»such»as»web»authentication»to»enable»
guest»access»and»MAC»authentication»for»endpoints»
that»do»not»have»an»IEEE»802.1x»supplicant.»All»three»
authentication»methods—»IEEE»802.1x,»MAC-based»
and»Web-based—can»be»enabled»simultaneously»on»
the»same»port.»This»is»called»tri-authentication.

sFlow

»» sFlow»is»an»industry»standard»technology»for»
monitoring»high-speed»switched»networks.»It»provides»
complete»visibility»into»network»use,»enabling»
performance»optimization,»usage»accounting/billing,»
and»defense»against»security»threats.»Sampled»
packets»sent»to»a»collector»ensure»it»always»has»a»
real-time»view»of»network»traffic.»

Terminal Access Controller Access–Control 
System Plus (TACACS+) Authentication 
»» TACACS+»provides»access»control»for»network»users»
from»a»centralized»server.»Authentication»is»carried»
out»via»communication»between»the»local»switch»and»
a»TACACS+»server»to»check»the»credentials»of»users»
seeking»network»access.
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Network Resiliency
The convergence of network services 
in the enterprise has led to increasing 
demand for highly available networks 
with minimal downtime. VCStack 
in conjunction with link aggregation 
provides a network with no single point 
of failure. The addition of EPSR ensures 
distributed network segments have high-
speed, resilient access to online resources 
and applications, as shown in diagram 1.

Network Virtualization
Virtual Routing and Forwarding (VRF 
Lite) allows multiple customers to 
share a common infrastructure, while 
maintaining their own independent 
virtual routing domains. While 
security for the individual customers is 
assured, they can still take advantage of 
shared resources such as printers and 
Internet access via filtered inter-VRF 
communication, as shown in diagram 2.

Diagram»1:»VCStack»and»EPSR

Diagram»2:»VRF»Lite
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Specifications

Performance

»» 48Gbps»of»stacking»bandwidth

»» Supports»9KB»jumbo»frames»

»» Wirespeed»multicasting

»» Up»to»32K»MAC»addresses»

»» 8K»Layer»3»entries

»» 512MB»DDR»SDRAM»»

»» 64MB»flash»memory

»» Packet»buffer»memory:»AT-x610-24Ts»-»2MB»
» » AT-x610-48Ts»-»4MB

Reliability

»» Modular»AlliedWare»Plus»operating»system

»» Redundant»Power»Supply»available»to»load»share»with»
internal»power»supply,»providing»uninterrupted»power»
and»extra»reliability

»» Full»environmental»monitoring»of»PSUs,»fans,»
temperature»and»internal»voltages.»SNMP»traps»alert»
network»managers»in»case»of»any»failure

Expandability

»» One»expansion»bay»

»» IPv6»routing»license»option

»» Advanced»Layer»3»license»option

Flexibility and Compatibility

»» Gigabit»SFP»ports»will»support»any»combination»of»
1000T,»1000X»SFPs,»1000SX,»1000LX,»or»1000ZX»
SFPs

Diagnostic Tools

»» Built-In»Self»Test»(BIST)

»» Ping»polling

»» Port»mirroring

»» Trace»route

General Routing

»» Black»hole»routing

»» Directed»broadcast»forwarding

»» DNS»relay

»» Equal»Cost»Multi-Path»(ECMP)»routing

»» Policy-based»routing

»» Route»maps»

»» Route»redistribution»(OSPF,»BGP,»RIP)

»» UDP»broadcast»helper»(IP»helper)

»» Up»to»eight»Virtual»Routing»and»Forwarding»(VRF»Lite)»
domains»(with»license)

IPv6 Features

»» 6to4»tunnelling

»» DHCPv6»relay,»DNSv6,»NTPv6

»» IPv4»and»IPv6»dual»stack

»» IPv6»management»via»Ping,»TraceRoute,»Telnet»and»
SSH

»» RA»guard

Management

»» Eco-mode»allows»ports»and»LEDs»to»be»disabled»to»
save»power

»» Web-based»Graphical»User»Interface»(GUI)

»» Industry-standard»CLI»with»context-sensitive»help

»» Powerful»CLI»scripting»tool

»» SD/SDHC»memory»card»socket»allowing»software»
release»files,»configurations»and»other»files»to»be»
stored»for»backup»and»distribution»to»other»devices.

»» Configurable»logs»and»triggers»provide»an»audit»trail»of»
SD»card»insertion»and»removal

»» Secure»Copy»(SCP)

»» Built-in»text»editor

»» Event-based»triggers»allow»user-defined»scripts»to»be»
run»upon»selected»system»events

Quality of Service

»» Limit»bandwidth»per»port»or»per»traffic»class»down»to»
64kbps

»» Wirespeed»traffic»classification»with»low»latency»
essential»for»VoIP»and»real-time»streaming»media»
applications

»» Policy-based»QoS»based»on»VLAN,»port,»MAC»and»
general»packet»classifiers

»» Policy-based»storm»protection

»» Extensive»remarking»capabilities

»» Strict»priority»scheduling,»weighted»round»robin»or»
mixed

»» RED»and»WRED»curves»for»drop»precedence

Resiliency

»» Stacking»ports»can»be»configured»as»10G»Ethernet»
ports

»» Control»plane»prioritization»ensures»the»CPU»always»has»
sufficient»bandwidth»to»process»network»control»traffic

»» Dynamic»link»failover

»» Ethernet»Protection»Switched»Rings»(EPSR)

»» Long-distance»stacking

»» Loop»protection»-»loop»detection

»» Loop»protection»-»thrash»limiting

»» Mix»up»to»four»x600»and»x610»units»in»the»same»
VCStack

»» PVST+»compatibility-mode

»» STP»root»guard

»» Stackable»up»to»eight»units»in»a»VCStack

»» VCStack»fast»failover»minimizes»network»disruption

Security Features

»» Access»Control»Lists»(ACLs)

»» Auth»fail»VLAN

»» BPDU»protection

»» DHCP»snooping,»IP»source»guard»and»dynamic»ARP»
inspection

»» DoS»attack»blocking»and»virus»throttling

»» Dynamic»VLAN»assignment

»» Guest»VLAN

»» MAC-based»authentication

»» Port-based»learn»limits»(intrusion»detection)

»» Private»VLANs,»providing»security»and»port»isolation»of»
multiple»customers»using»the»same»VLAN

»» Strong»password»security

»» Web-based»authentication

Environmental Specifications

»» Operating»temperature»range:»»
0°C»to»40°C»(32°F»to»104°F)»
Derated»by»1°C»per»305»meters»(1,000»ft)

»» Storage»temperature»range:»»
-25°C»to»70°C»(-13°F»to»158°F)

»» Operating»relative»humidity»range:»»
5%»to»90%»non-condensing

»» Storage»relative»humidity»range:»»
5%»to»95%»non-condensing

»» Operating»altitude:»
3,048»meters»maximum»(10,000»ft)

»» Front»to»back»forced»air»cooling

Electrical Approvals and Compliances

»» EMC:»EN55022»class»A,»FCC»class»A,»VCCI»class»A

»» Immunity:»EN55024,»EN61000-3-levels»2»
(Harmonics),»and»3»(Flicker)»–»AC»models»only

Safety

»» Standards:»UL60950-1,»CAN/CSA-C22.2»No.»
60950-1-03,»EN60950-1,»EN60825-1,»AS/NZS»
60950.1

»» Certification:»UL,»cUL,»TUV

Restrictions on Hazardous Substances (RoHS) 
Compliance
»» EU»RoHS»compliant

»» China»RoHS»compliant

Country of Origin

»» Singapore
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Product Width dePth height Mounting
Weight

MtBF (hours)
Unpackaged packaged

At-x610-24ts 440 mm (17.32 in) 420 mm (16.54 in) 44 mm (1.73 in) Rack mount 6.3 kg (13.89 lb) 8.8 kg (19.4 lb) 80,000

At-x610-24ts-Poe+ 440 mm (17.32 in) 420 mm (16.54 in) 44 mm (1.73 in) Rack mount 5.6 kg (12.35 lb) 7.6 kg (16.76 lb) 160,000*

At-x610-24ts/X 440 mm (17.32 in) 420 mm (16.54 in) 44 mm (1.73 in) Rack mount 6.3 kg (13.89 lb) 9.7 kg (21.38 lb) 80,000

At-x610-24ts/X-Poe+ 440 mm (17.32 in) 420 mm (16.54 in) 44 mm (1.73 in) Rack mount 5.6 kg (12.35 lb) 7.6 kg (16.76 lb) 150,000*

At-x610-24sPs/X 440 mm (17.32 in) 420 mm (16.54 in) 44 mm (1.73 in) Rack mount 6.6 kg (14.55 lb) 9.2 kg (20.3 lb) 70,000

At-x610-48ts 440 mm (17.32 in) 420 mm (16.54 in) 44 mm (1.73 in) Rack mount 6.7 kg (14.77 lb) 9.0 kg (19.84 lb) 70,000

At-x610-48ts-Poe+ 440 mm (17.32 in) 420 mm (16.54 in) 44 mm (1.73 in) Rack mount 6.0 kg (13.23 lb) 7.8 kg (17.2 lb) 120,000*

At-x610-48ts/X 440 mm (17.32 in) 420 mm (16.54 in) 44 mm (1.73 in) Rack mount 6.8 kg (14.99 lb) 9.8 kg (21.61 lb) 60,000

At-x610-48ts/X-Poe+ 440 mm (17.32 in) 420 mm (16.54 in) 44 mm (1.73 in) Rack mount 6.0 kg (13.23 lb) 8.5 kg (18.74 lb) 120,000*

At-rPs3000 440 mm (17.32 in) 360 mm (14.17 in) 44 mm (1.73 in) Rack mount 4.3 kg (9.48 lb) 6.1 kg (13.45 lb) 440,000*

At-PWr250 Ac 150 mm (5.9 in) 27.5 mm (10.83 in) 42 mm (1.65 in) Internal 1.5 kg (3.31 lb) 2.7 kg (5.95 lb) 170,000

At-PWr250 dc 150 mm (5.9 in) 27.5 mm (10.83 in) 42 mm (1.65 in) Internal 1.5 kg (3.31 lb) 2.7 kg (5.95 lb) 180,000

At-PWr800 150 mm (5.9 in) 27.5 mm (10.83 in) 42 mm (1.65 in) Internal 1.8 kg (3.97 lb) 2.9 kg (6.39 lb) 150,000

At-PWr1200 150 mm (5.9 in) 330 mm (13 in) 42 mm (1.65 in) Internal 2.2 kg (4.85 lb) 4.5 kg (9.92 lb) 100,000

At-x6eM/Xs2 150 mm (5.9 in) 95 mm (3.74 in) 30 mm (1.18 in) Internal 0.2 kg (0.44 lb) 0.5 kg (1.1 lb) 2,130,000

At-stackXg 147 mm (5.8 in) 86 mm (3.4 in) 31 mm (1.2 in) Internal 0.131 kg (0.35 lb) 0.75 kg (1.65 lb) 6,850,000

Physical Specifications and MTBF Figures

Product
internAl Psu or At-PWr250 (no Poe loAd) At-PWr800 (Full Poe+ loAd) At-PWr1200 (Full Poe+ loAd)

max power
consUmption

max heat
dissipation noise max power

consUmption
max heat

dissipation noise max power
consUmption

max heat
dissipation noise

At-x610-24ts 81W 299 BTU/hr 51.2 dBA - - - - - -

At-x610-24ts-Poe+ 87W 299 BTU/hr 51.2 dBA 632W 708 BTU/hr 51.8 dBA 930W 913 BTU/hr

At-x610-24ts/X 89W 320 BTU/hr 51.2 dBA - - - - - -

At-x610-24ts/X-Poe+ 92W 320 BTU/hr 51.2 dBA 636W 729 BTU/hr 51.8 dBA 935W 934 BTU/hr

At-x610-24sPs/X 88W 375 BTU/hr 51.2 dBA - - - - - -

At-x610-48ts 112W 405 BTU/hr 51.2 dBA - - - - - -

At-x610-48ts-Poe+ 119W 405 BTU/hr 51.2 dBA 673W 815 BTU/hr 51.8 dBA 1,027W 1071 BTU/hr

At-x610-48ts/X 120W 427 BTU/hr 51.2 dBA - - - - - -

At-x610-48ts/X-Poe+ 125W 427 BTU/hr 51.2 dBA 681W 836 BTU/hr 51.8 dBA 1,034W 1092 BTU/hr

Power and Noise Characteristics

PoWer suPPlY 
unit

Poe PoWer
AvAilABle

MAXiMuM Poe Ports suPPorted

class 1
(4.0 w)

class 2
(7.0 w)

class 3
(15.4 w)

class 4
(30 w)

At-PWr250 - - - - -

At-PWr800 480W 48 48 31 16

At-PWr1200 780W 48 48 48 26

PSU PoE Options

*Excluding PSU

*NOISE: tested to ISO7779; front bystander position

Product 10/100/1000t (rJ-45) 
coPPer Ports

100/1000X  
sFP Ports

1000X  
sFP coMBo Ports

10gigABit sFP+ 
Ports

MAX Poe+ 
Ports

sWitching
FABric ForWArding rAte

At-x610-24ts 24 - 4 - 2* - 96Gbps 71.4Mpps

At-x610-24ts-Poe+ 24 - 4 - 2* 24 96Gbps 71.4Mpps

At-x610-24ts/X 24 - 4 2 4* - 136Gbps 101.2Mpps

At-x610-24ts/X-Poe+ 24 - 4 2 4* 24 136Gbps 101.2Mpps

At-x610-24sPs/X - 24 4† 2 4* - 136Gbps 101.2Mpps

At-x610-48ts 48 - 4 - 2* - 144Gbps 107.1Mpps

At-x610-48ts-Poe+ 48 - 4 - 2* 48 144Gbps 107.1Mpps

At-x610-48ts/X 48 - 2 2 4* - 184Gbps 136.9Mpps

At-x610-48ts/X-Poe+ 48 - 2 2 4* 48 184Gbps 136.9Mpps

* with AT-x6EM/XS2 module in standalone switch† 10/100/1000T RJ-45 copper ports
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Standards and Protocols

AlliedWare Plus Operating System 
Version»5.4.1»or»higher

Authentication
RFC»1321» MD5»Message-Digest»algorithm
RFC»1828» IP»authentication»using»keyed»MD5

Border Gateway Protocol (BGP)
BGP»dynamic»capability
BGP»graceful»restart
BGP»outbound»route»riltering
Extended»communities»attribute
RFC»1771» Border»Gateway»Protocol»4»(BGP-4)
RFC»1772» Application»of»the»Border»Gateway»Protocol»in»»

» the»Internet
RFC»1997» BGP»communities»attribute
RFC»2385» Protection»of»BGP»sessions»via»the»TCP»MD5»»

» signature»option
RFC»2439» BGP»route»flap»damping
RFC»2796» BGP»route»reflection»-»an»alternative»to»full»mesh»

» IBGP
RFC»2858» Multiprotocol»extensions»for»BGP-4
RFC»2918» Route»refresh»capability»for»BGP-4
RFC»3065» Autonomous»system»confederations»for»BGP
RFC»3107» Carrying»label»information»in»BGP-4
RFC»3392» Capabilities»advertisement»with»BGP-4
RFC»4893» BGP»support»for»four-octet»AS»number»space

Encryption
FIPS»180-1» Secure»Hash»Standard»(SHA-1)
FIPS»186» Digital»signature»standard»(RSA)
FIPS»46-3» Data»Encryption»Standard»(DES»and»3DES)

Ethernet
IEEE»802.1AX-2008»link»aggregation»(static»and»dynamic)
IEEE»802.2» Logical»Link»Control
IEEE»802.3» Ethernet»CSMA/CD
IEEE»802.3ab»1000T
IEEE»802.3ae»10»Gigabit»Ethernet
IEEE»802.3af» Power»over»Ethernet»(PoE)
IEEE»802.3at» Power»over»Ethernet»Plus»(PoE+)
IEEE»802.3u» 100TX
IEEE»802.3x» Flow»control»-»full-duplex»operation
IEEE»802.3z» Gigabit»Ethernet

General Routing
RFC»768» User»Datagram»Protocol»(UDP)
RFC»791» Internet»Protocol»(IP)
RFC»792» Internet»Control»Message»Protocol»(ICMP)
RFC»793» Transmission»Control»Protocol»(TCP)
RFC»826» Address»Resolution»Protocol»(ARP)
RFC»894» Standard»for»the»transmission»of»IP»datagrams»»

» over»Ethernet»networks
RFC»903» Reverse»ARP
RFC»919» Broadcasting»Internet»datagrams
RFC»922» Broadcasting»Internet»datagrams»in»the»»

» presence»of»subnets
RFC»932» Subnetwork»addressing»scheme
RFC»950» Internet»standard»subnetting»procedure
RFC»951» Bootstrap»Protocol»(BootP)»relay»and»server
RFC»1027» Proxy»ARP
RFC»1035» DNS»client
RFC»1042» Standard»for»the»transmission»of»IP»datagrams»»

» over»IEEE»802»networks
RFC»1071» Computing»the»Internet»checksum
RFC»1122» Internet»host»requirements
RFC»1191» Path»MTU»discovery
RFC»1256» ICMP»router»discovery»messages
RFC»1518» An»architecture»for»IP»address»allocation»with»»

» CIDR

RFC»1519» Classless»Inter-Domain»Routing»(CIDR)
RFC»1542» Clarifications»and»extensions»for»the»bootstrap»

» protocol
RFC»1591» Domain»Name»System»(DNS)
RFC»1812» Requirements»for»IPv4»routers
RFC»1918» IP»addressing
RFC»2581» TCP»congestion»control

IPv6 Features
RFC»1981» Path»MTU»discovery»for»IPv6
RFC»2460» IPv6»specification
RFC»2464» Transmission»of»IPv6»packets»over»Ethernet»

» networks
RFC»3056» Connection»of»IPv6»domains»via»IPv4»clouds
RFC»3484» Default»address»selection»for»IPv6
RFC»3596» DNS»extensions»to»support»IPv6
RFC»4007» IPv6»scoped»address»architecture
RFC»4193» Unique»local»IPv6»unicast»addresses
RFC»4291» IPv6»addressing»architecture
RFC»4443» Internet»Control»Message»Protocol»(ICMPv6)
RFC»4861» Neighbor»discovery»for»IPv6
RFC»4862» IPv6»stateless»address»autoconfiguration
RFC»5014» IPv6»socket»API»for»source»address»selection
RFC»5095» Deprecation»of»type»0»routing»headers»in»IPv6
RFC»5175» IPv6»router»advertisement»flags»option

Management
AT»Enterprise»MIB
IEEE»802.1ab»Link»Layer»Discovery»Protocol»(LLDP)
RFC»1155» Structure»and»identification»of»management»

» information»for»TCP/IP-based»Internets
RFC»1157» Simple»Network»Management»Protocol»(SNMP)
RFC»1212» Concise»MIB»definitions
RFC»1213» MIB»for»network»management»of»TCP/IP-based»

» Internets:»MIB-II
RFC»1215» Convention»for»defining»traps»for»use»with»the»»

» SNMP
RFC»1227» SNMP»MUX»protocol»and»MIB
RFC»1239» Standard»MIB
RFC»1493» Bridge»MIB
RFC»1724» RIPv2»MIB»extension
RFC»2011» SNMPv2»MIB»for»IP»using»SMIv2
RFC»2012» SNMPv2»MIB»for»TCP»using»SMIv2
RFC»2013» SNMPv2»MIB»for»UDP»using»SMIv2
RFC»2096» IP»forwarding»table»MIB
RFC»2574» User-based»Security»Model»(USM)»for»SNMPv3
RFC»2575» View-based»Access»Control»Model»(VACM)»for»
» » SNMP
RFC»2674» Definitions»of»managed»objects»for»bridges»with»

» traffic»classes,»multicast»filtering»and»VLAN»
» extensions

RFC»2741» Agent»Extensibility»(AgentX)»protocol
RFC»2787» Definitions»of»managed»objects»for»VRRP
RFC»2819» RMON»MIB»(groups»1,2,3»and»9)
RFC»2863» Interfaces»group»MIB
RFC»3164» Syslog»protocol
RFC»3176» sFlow:»A»method»for»monitoring»traffic»in»

» switched»and»routed»networks
RFC»3412» Message»processing»and»dispatching»for»the»

» SNMP
RFC»3413» SNMP»applications
RFC»3418» MIB»for»SNMP
RFC»3621» PoE»MIB
RFC»3635» Definitions»of»managed»objects»for»the»Ethernet-»

» like»interface»types
RFC»3636» IEEE»802.3»MAU»MIB
RFC»4188» Definitions»of»managed»objects»for»bridges
RFC»4318» Definitions»of»managed»objects»for»bridges»with»»

» RSTP
RFC»4560» Definitions»of»managed»objects»for»Remote»Ping,»

» Traceroute,»and»Lookup»Operations

Multicast Support
Bootstrap»router»for»PIM-SM
IGMP»proxy
IGMP»query»solicitation
IGMP»snooping
RFC»1112» Host»extensions»for»IP»multicasting
RFC»2236» Internet»Group»Management»Protocol»v2»»

» (IGMPv2)
RFC»2362» PIM-SM
RFC»2715» Interoperability»rules»for»multicast»routing»»

» protocols
RFC»3376» IGMPv3
RFC»3973» PIM-DM
RFC»4541» IGMP»and»MLD»snooping»switches

Open Shortest Path First (OSPF)
Graceful»OSPF»restart
OSPF»link-local»signaling
OSPF»MD5»authentication
OSPF»restart»signaling
OSPF»TE»extensions
OSPFv3»TE»extensions
Out-of-band»LSDB»resync
RFC»1245» OSPF»protocol»analysis
RFC»1246» Experience»with»the»OSPF»protocol
RFC»1370» Applicability»statement»for»OSPF
RFC»1765» OSPF»database»overflow
RFC»2328» OSPFv2
RFC»2370» OSPF»opaque»LSA»option
RFC»2740»» OSPFv3»for»IPv6
RFC»3101» OSPF»Not-So-Stubby»Area»(NSSA)»option
RFC»3509» Alternative»implementations»of»OSPF»area»

» border»routers

Quality of Service
IEEE»802.1p»priority»tagging
RFC»2211» Specification»of»the»controlled-load»network»

» element»service
RFC»2474» DiffServ»precedence»for»eight»queues/port
RFC»2475» DiffServ»architecture
RFC»2597» DiffServ»Assured»Forwarding»(AF)
RFC»2697» A»single-rate»three-color»marker
RFC»2698» A»two-rate»three-color»marker
RFC»3246» DiffServ»Expedited»Forwarding»(EF)

Resiliency Features
IEEE»802.1D-2004» MAC»bridges
IEEE»802.1D-2004»» Rapid»Spanning-Tree»Protocol»(RSTP)
IEEE»802.1Q-2005»» Multiple»Spanning-Tree»Protocol»(MSTP)
RFC»3768»» Virtual»Router»Redundancy»Protocol»»

» (VRRP)

Routing Information Protocol (RIP)
RFC»1058» Routing»Information»Protocol»(RIP)
RFC»2080» RIPng»for»IPv6
RFC»2081» RIPng»protocol»applicability»statement
RFC»2082» RIP-2»MD5»authentication
RFC»2453» RIPv2
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Security Features
SSH»remote»login
SSLv2»and»SSLv3
TACACS+»accounting
TACACS+»authentication
IEEE»802.1x»authentication»protocols»(TLS,»TTLS,»PEAP»and»

MD5)
IEEE»802.1x»multi-supplicant»authentication
IEEE»802.1x»port-based»Network»Access»Control
RFC»2246» TLS»protocol»v1.0
RFC»2865» RADIUS
RFC»2866» RADIUS»accounting
RFC»2868» RADIUS»attributes»for»tunnel»protocol»support
RFC»3546» Transport»Layer»Security»(TLS)»extensions
RFC»3579» RADIUS»support»for»Extensible»Authentication»»

» Protocol»(EAP)
RFC»3748» PPP»Extensible»Authentication»Protocol»(EAP)
RFC»4251» Secure»Shell»(SSHv2)»protocol»architecture
RFC»4252» Secure»Shell»(SSHv2)»authentication»protocol
RFC»4253» Secure»Shell»(SSHv2)»transport»layer»protocol
RFC»4254» Secure»Shell»(SSHv2)»connection»protocol

Services
RFC»854» Telnet»protocol»specification
RFC»855» Telnet»option»specifications
RFC»857» Telnet»echo»option
RFC»858» Telnet»suppress»go»ahead»option
RFC»1091» Telnet»terminal-type»option
RFC»1350» Trivial»File»Transfer»Protocol»(TFTP)
RFC»1985» SMTP»service»extension
RFC»2049» MIME
RFC»2131» DHCP»for»IPv4
RFC»2132» DHCP»options»and»BOOTP»vendor»extensions
RFC»2554» SMTP»service»extension»for»authentication
RFC»2616» Hypertext»Transfer»Protocol»-»HTTP/1.1
RFC»2821» Simple»Mail»Transfer»Protocol»(SMTP)
RFC»2822» Internet»message»format
RFC»3046» DHCP»relay»agent»information»option»(DHCP»»

» option»82)
RFC»3993» Subscriber-ID»suboption»for»DHCP»relay»agent»»

» option
RFC»5905» Network»time»protocol»version»4

VLAN Support
Generic»VLAN»Registration»Protocol»(GVRP)
IEEE»802.1ad»Provider»bridges»(VLAN»stacking,»Q-in-Q)
IEEE»802.1Q-2005»Virtual»LAN»(VLAN)»bridges
IEEE»802.1v»VLAN»classification»by»protocol»and»port
IEEE»802.3ac»VLAN»tagging

VoIP Support
LLDP-MED»ANSI/TIA-1057
Voice»VLAN

Feature Licenses

1»The»standard»switch»software»supports»64»OSPF»routes.»The»advanced»Layer»3»license»supports»12K»OSPF»routes.»
2»100»users»and»24»NAS»can»be»stored»in»local»RADIUS»database»with»base»software.»

Ordering Information

AT-x610-24Ts-60
24 x 10/100/1000T (RJ-45) copper ports, 4 x 1000X 

SFP combo ports, internal PSU

AT-x610-24Ts-POE+-00
24 x 10/100/1000T (RJ-45) copper ports Power over 

Ethernet (IEEE 802.3at), 4 x 1000X SFP combo 
ports, removable PSU (PSU not included)

AT-x610-24Ts/X-60
24 x 10/100/1000T (RJ-45) copper ports, 4 x 1000X 

SFP combo ports, 2 x SFP+ ports, internal PSU

AT-x610-24Ts/X-POE+-00
24 x 10/100/1000T (RJ-45) copper ports, Power 

over Ethernet (IEEE 802.3at), 4 x 1000X SFP 
combo ports, 2 x SFP+ ports, removable PSU 
(PSU not included)

AT-x610-24SPs/X-60
24 x 100/1000X SFP ports, 4 x 10/100/1000T 

combo ports, 2 x SFP+ ports, internal PSU

AT-x610-48Ts-60
48 x 10/100/1000T (RJ-45) copper ports, 4 x 1000X 

SFP combo ports, internal PSU

AT-x610-48Ts-POE+-00
48 x 10/100/1000T (RJ-45) copper ports, Power 

over Ethernet (IEEE 802.3at), 4 x 1000X SFP 
combo ports, removable PSU (PSU not included)

AT-x610-48Ts/X-60
48 x 10/100/1000T (RJ-45) copper ports, 2 x 1000X 

SFP combo ports, 2 x SFP+ ports, internal PSU

AT-x610-48Ts/X-POE+-00
48 x 10/100/1000T (RJ-45) copper ports, Power 

over Ethernet (IEEE 802.3at), 2 x 1000X SFP 
combo ports, 2 x SFP+ ports, removable PSU 
(PSU not included)

x610 Series

nAMe descriPtion includes
At-Fl-x610-01 x610 advanced Layer 3 license »» OSPF1

»» PIM-SM
»» PIM-DM
»» BGP4
»» VLAN»double»tagging»(Q-in-Q)
»» VRF»Lite

At-Fl-x610-02 x610 IPv6 pack »» IPv6»management
»» IPv6»static»routes
»» IPv6»unicast»forwarding
»» RIPng
»» OSPFv3
»» MLD»snooping

At-Fl-rAdius-Full Increase local RADIUS server support limits2 »» 5000»users
»» 1000»NAS
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Where»xx»=» 10»for»US»power»cord
» 20»for»no»power»cord
» 30»for»UK»power»cord
» 40»for»Australian»power»cord
» 50»for»European»power»cord

Expansion Modules

AT-x6EM/XS2-00
Expansion module (2 x SFP+) for long-distance 

stacking or two additional 10GbE ports

AT-StackXG-00
Expansion module with one AT-StackXG/0.5-00 

cable included

10GbE SFP+ Modules

AT-SP10SR
10GSR 850 nm short-haul, 300 m with MMF

AT-SP10LR
10GLR 1310 nm medium-haul, 10 km with SMF

SFP Modules

AT-SPFX/2
100FX multi-mode 1310 nm fiber up to 2 km

AT-SPFX/15
100FX single-mode 1310 nm fiber up to 15 km

AT-SPFXBD-LC-13
100BX Bi-Di (1310 nm Tx, 1550 nm Rx) fiber up to 

10 km

AT-SPFXBD-LC-15
100BX Bi-Di (1550 nm Tx, 1310nm Rx) fiber up to 

10 km

AT-SPTX
1000T 100 m copper

AT-SPSX
1000SX GbE multi-mode 850 nm fiber up to 550 m

100Mbps SFP modules are only compatible with 
the AT-x610-24SPs/X switch

AT-SPSX/I
1000SX GbE multi-mode 850 nm fiber up to 550 m 

industrial

AT-SPEX
1000X GbE multi-mode 1310 nm fiber up to 2 km

AT-SPLX10
1000LX GbE single-mode 1310 nm fiber up to 10 km

AT-SPLX10/I
1000LX GbE single-mode 1310 nm fiber up to 10 km 

Industrial

AT-SPBD10-13 
1000LX GbE Bi-Di (1310 nm Tx, 1490 nm Rx) fiber 

up to 10 km

AT-SPBD10-14 
1000LX GbE Bi-Di (1490 nm Tx, 1310 nm Rx) fiber 

up to 10 km

AT-SPLX40 
1000LX GbE single-mode 1310 nm fiber up to 40 km

AT-SPZX80
1000ZX GbE single-mode 1550 nm fiber up to 80 km
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Cables

AT-StackXG/0.5-00
0.5 meter cable for stacking

AT-StackXG/1-00
1 meter cable for stacking

AT-SP10TW1
1 meter SFP+ direct attach cable

AT-SP10TW3
3 meter SFP+ direct attach cable

AT-SP10TW7
7 meter SFP+ direct attach cable

Power Supply Accessories

AT-RPS3000-00
Chassis for up to two redundant power supplies 

(PSUs not included)

AT-PWR250-xx
Additional 250W AC system power supply

AT-PWR250-80
Additional 250W DC system power supply

AT-RPS-CBL1.0
1 meter RPS cable

PoE Power Supplies

AT-PWR800-xx
Additional 800W AC system and PoE+ power supply

AT-PWR1200-xx
Additional 1200W AC system and PoE+ power 

supply


